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Clip the region of interest

® ASTER image cover 60km x 60km.

spacesystems

® When your region of interest is locally, you should extract this region before

processing.

ASTER |mage it
(R band3 G: bandZ B band3)
\h .

ASTER |mage i

(R: band3 G:band2, B band3)
4N
h»

60 km
® File size becomes small.

® Processing of data becomes fast

2
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Goal of this practise @spacesysfems

Two ASTER images Merge Clip

We will use these clipped data in following lesson.
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Open ASTER image

® From “Layer” menu, select “Add Layer” and “Add Raster Layer”.
® Select files with the vnirl, vnir2, vnir3n.

@ untitled Project - QGIS

- X
[ Settings Plugins Vector Raster Database Web Mesh SCP Progessing Help
0 Data Source Manager Cirl+L - - 1 [l ja— T a
a 2 [Luiing -
— . o b #* Z ‘ =18
Add Layer Vg, Add Vector Layer... Ctrl+Shift+V
= Embed Layers and Groups.. - Add Raster La Ctri+Shift+R
yers
Vs |« 4, Addirom Loyer Defnon File. B Add Mesh Layer..
= 9, Add Delimited Text Layer. Ctrl+Shift+T
o W, Add PosiGIS Layers... Cirl+Shift+D
) /% Add Spatialite Layer. Cirl+ShiftsL
9 B Add MISSQL Spatial Layer...
/; . T, Add D82 Spatial Layer... Ctrl+Shift+2
a Add Oracle Spatial Layer.. Cirl+Shift+0
,qj roce patialteyer e Q Open GDAL Supported Raster Dataset(s) X
@ - ) Add/Edit Virtual Layer...
Q. Current £ ) Add WMS/WMTS Layer. Cirl+ShiftsW 0t L
o - ) Add ArcGIS MapServer Layer.. < 1+ > PC » FFaxYhk » Country > Uganda > 108050839101305159007 v O
@ = . @ Add WCS Layer.
@ FLL -
% cp () Add WFS Layer... FLWTAILA L
(‘-’3 &2 Add ArcGIS FeatureServer Layer.. = A~
g - 0]
e e #* 7497 7782 .
|IU:| Cileshiftec | ] datat.13a.demsh
o @ OneDrive [&] datat.3a.demazs.tif
& il v [ pc L] datal.l3a.gh
b o |&] datat.l3a.swird.tif
& Show in Overview B 3D ATIII P
:ﬁ ol O 3 |&] datatl.3a.swirs.tif
©0 Show All in Overview #9yn-F = S
2 Hide Al from Overview i &] datat.3a.swir6.if
B 7277 |&] datal.l3a.swir7.tif
> & Baxuk |&] datat.3a.swir.tif

E9F% |8] datat.l3a.swird.tif
| | datat.I3a.swirsh
|s] datat.l3atirio.tif
|8] datat.l3a.tirt1.tif
|&] datat.3atiri2.tif
|&] datat.i3a.tir13.tf
— HD-PGF-A (D) [8] datat.i3a.tina.tif
| ] datat.3a.tirsh

|&] datat.3a.vnirt.tif
|&] datat.l3a.vnir2.tif
|&] datat.I3a.vnir3n.tif
| | datat.I3a.vnirsh

‘s Windows (C)
s HD-PGF-A (D)

& F9b7-7

Bromser | Layers

< >
Q, Type 1o locate (Crl+K) Resdy

T74 IV &(N): | "datat.3a.vnir3n.tif" "datal.3a.vnirl.tif" "datat.l3a.vnir2.tif" v| All files (%) v
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Open ASTER image @spacesysfems

® Selected images are opened separately.

( *Untitled Project - QGIS — X
Project Edit View Layer Settings Plugins Vector Raster Database Web Mesh SCP Processing Help
B P = ) @ O 2] [0 ~~ [ My i\ @ @ 1
{rj ‘0‘ ¢‘!’, )_,’ ;} L}\ g_) m ( o M; H | "y Ny ?LO % Al V] lgﬁ l\!d » » » a > ‘0-.,?, » P> »

B A
Layers @®
« @l e T -HEAD

~ v ¥ datali3avnir3n
W
227

~ V| ¥ datall3avnir2
o
255

~ V| ™ datall3a.vnirl
o
255

.—;ﬁfgégj'@@o‘@n\o\.%:’oﬁ

P

g B

Browser Layers

Q. Type to locate (Crl+K) Ready Coordinate | 30028-0374 | Scale [1:430413  ~ | (@ Menifier 100K $ | Rotation |00° 2| VI Render S erscazes @ £
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Check property @spacesysfems

® Select layer, click right mouse button and select “Properties”.
® Select “Symbology” and click “Band1 (Gray)"”.
® Confirm that there is only one band.

(@ *Untitled Project - QGIS
Project Edit View Layer Settings Plugins Vector Raster Database Web Mesh SCP Processing Help

@ S ONS) ;] g\ [ 4 I EE R A fiel fio ¢ @@ » > ho» &> A
B %

Layers @®
Vo leamyi-man

'O {0 Zoom to Layer -]
o

03 Show in Overview

22
v (V| @ da  CopyLayer
Ho Rename Layer
25|
> V| ¥ da

. 0 Stretch Using Current Extent

g Q@ Layer Properties - datal.3a.vnir3n | Symbology

J Zoom to Native Resolution (100%)

w Band Rendering

- -
25| ] Duplicate Layer G Information Render type | Singleband eray -

[Cl Remove Layer...

S source Gray bend
Change Data Source... i

<

\4’@@6.@0\0\’:%

Set Layer Scale Visibility... « Symbology Caolor gradient | Black to white =
V Set CRS » Min |0 Max 227
&2~
=g Ex l.ﬂ Transparency
port » 3 psasies Contrast -
TR Stretch to Minbax =

Styles »

o n Histogram P Min / Max Value Settings

"/ Rendering

(&

o "?

w Color Rendering

b
ji7 ‘ Pyramids Blending mode | Mormal = # Resst
F T Brieh e 1] - i e 0 -
l Metadata rightness = ontrast =
3 c - Saturation — 0 | | Grayscale | Off -
Legend
Hue Colorize Strength 100%
QGIS Server
P Resampling
Thumbnail Legend Palette
Browser Layers
L Type to locate (Gtri+K) Ready Coordinate | 23938.-0587 |5 Scale |1:430413
Style - ‘ Ok | Cancel Bpply Help
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Merge single-band layer in multi-band layer iR/

® From “Raster” menu, select “Miscellaneous” and “Merge”.
® Open “Merge” window and check three boxes of layers.

(@ *Untitled Project - QGIS — ¥
Project Edit View Layer Settings Plugins Vector IEE Database Web Mesh SCP Processing Help
. D (D m m[m O ¥ Raster Calculator... R\ » @ @ 1
e s LRI PR RS fe Il fle % 6 @ & - . ar @ A
Align Rasters...
| 11 Georeferencer... Je) E;,Y %
el )
Layers Analysis
\/ ; Projections
o |« @l ® Y - B O L .
. Miscellaneous & ¥ Build Virtual Raster...
'0 *,» datal.l3a.vnir3n r .
. 0 Extraction B} Raster Information...
% 227 Conversion >
, ~ V| ¥ datall3avnir2 W, Build Overviews (Pyramids)...
]
mo B2 Tile Index..
f 255 ¢
70 v V| ¥ datal.l3awvnirl
1 Mo _
“' 255 @ Men
A
@ - Parameters Log
Input layers =
% 0 elements zelected
KYB b Grab pzeudocolor table from first laver
\/ Mo Place each input file into a separate band
5 Output data type
&
%] Float32 ot
| w Advanced parameters
i Thput pizel value to treat az “nodata” [optional]
E*E:‘ Mot set | () Multiple selection *
x fiszien sped
N V| datal.l3awvnir! [EPSG:4326] | Select Al |
ot set V| datal3avnir2 [EPSG4326] e —
Additional of || datal.|3awvnir3n [EPSG:4326] Clear Selection
Prafile  Def Togele Selection
= Add Filelz):
) Add Directory
Browser Layers &
L Type to locate (Gtrl+K) Ready Cor ol Cancel 0n* 2| VIRender @ ersaaaze @ £
| 0% CGancel
Fun az Batch Process Fun Claze Help
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Merge single-band layer in multi-band laye

@spacesysfems

® Check the box of “Place each input file into a separate band”.
® Seclect “Byte” after confirming the data type from property-Information tab.

() Layer Properties - datal.|3a.vnir3n | Informaticn *

(@ *Untitled Project - QGIS

Project Edit View Layer Settings Plugins Vector IEE Database Web Mesh SCP Processing H

m @ | ¥ Raster Calculator...
» P i

A, Y
OO &
@ A Align Rasters...

| 11 Georeferencer...

o Information

a

Information from provider

J{:\'_- Source

i Name datal.l3a.vnir3n
Layers Analysis ' Path C C
voo R ¢ e Al | Projections %’ Symbology a 4 .
Miscell, Pr Y ——————
'Q »» datal.l3a.vnir3n BEE neous lﬂ s - datat 13a. SNt
Ho Extraction ey LIS, CRS EPSG:4326 - WGS 84 - Geographic
227 Conversion >
% - Extent 30.0283626388999991,-0.9766955333000000 :
v V| ¥ datall3awvnir2 . Build Overvi & Histogram ’ . '
% Ho A = 30.7105958596999997,-0.3364956389000000
£ @ Merge c/ Rendering Unit degrees
E Width 5064
' Parameters | Log ‘ Pyramids Height 4752
“ Input layers N Data Byte - Eight bit unsigned integer
@ 3 elements selected ! Metadata type
% Grab peeudocolor table from first laver = p— GB’AL GTiff
A7 ||V Place each input file into a separate band Driver
&7
- Output data type AEBETT Descripti
v on
g | s GDAL GeoTIFF
Ulnt1s Driver
| || Uintz2 Metadata
q || =2 Dataset C:\Users\Kazuyo
| || Froats2 Descripti  Hirose\Documents\Country\Uganda\10805083910130515900
L Fosts on 7\data1.3a.vnir3n.if
ntlg
Compres
CInt32
CFloat32 sion T
CFloate4 Style | 0] 4 | Gatcel Apply Help
1 di | = [ [T 7| 9338-0587 | Scele 1430413~ | (g Menifer |100% <! Rotstion |00° 2| VIRender @ ersaaaze @ £
| 0% Cancel
Rur az Batch Process | Rur | Close Help
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Merge single-band layer in multi-band layer iR/

® Click Button - and save to file as “ASTER_20010805_Band123_Uganda-1
® Click Run

D D 1} Fl & @
Vel PPLA . RBHEIUS Wittt -
2 Savefile
Q Layers| € v 4 » PC » FF1iYb » Country » Uganda > 108050B39101305159007 ~
= Vc: Al =11
7z — o = : = EE - FLWIANT-
=) F‘: [ @ T | [ B | Bl B -~ ! .
7~ > 2 4 ‘ R/~ ML HX g o o i $4% 57
ﬁ] s DA9D FIEA
| HE =] data.2a.demas.tif TIF 774 )L
,o T V| @ OneDrive 8] datat.l3aswird.tif TIF 774 )l
— e =] datat.|3a.swirs.tif TIF 774k
Layers ox f% - P |&] datat.|3a.swirs.tif TIF 74l
v(; & ﬁ[m ) Y ;3 1 1 'ﬁ :-Sf v |&] datat.|3aswirT.tif TIF 774 )l
=l - oyO-f n . -
|&] datat.I3a.swirs.tif TIF 771k
'Q ~ V| ¥ datall3awnir3n 'g = W 727k T 5] datatl3aswira.tif TIF 7740l
. 0 @ - [F FFaxyb [&] datal.|za.tirl0 i TIF 71
% 227 = EOFv |&] datat.3a.tir11tif TIE 7740
’ ~ [V| 3 datali3avnir2 % B e |u] datat.3atiriztif TIF 774 )l
() . o IVEJ' i P svws |&] datat.I3a.tir3.tif TIF 771
P & Windows (1 u] datat.i3atirid.if TIF 274 )b
ﬁ} 255 V- & Windows (C) 5] datat. Bavnir.tif TIE 774 )l
3 v V| ¥ datal.l3avnirl o = HD-PGE-A (D) (8] datat. Bavnira.tif TIF 7741l
@ . 0 b = HD-PGF-A (DY) =] datal.3avnir3n.tif TIF J71
_ 255 |
ﬂ = o F9h0-7
- I
Q
]
[
Sy |8 . @ | ASTER 20010805 Band123 Uganda-1
@ Parameters | Log
V" o= vaiuae ) =
VH ~ 0 . o 7 N): | ASTER_20010805_Band123 Uganda-1
Z Additional command-line parameters [optional] 2 | = e gene
NV T7{ LR [TIF files (~4f)
-
5 Braw] o=
@,:I Merged L Type 10 log . . . . —

e to temporary file] x "
2 i e ave to a Temporary File

w

—<3 v Open output file after running algorithm

1 e to
@:' EOAal e ol Change File Encoding (System)...
python3 -m edal merge —separate -ot Byte -of GTiff -0 C: Cop—
y ¥Users¥KAZUYO™ 1¥AppData¥Local¥ Temp/

processing_| 8d84cbf9da1a402abcce01f2360f83??/lﬁ3ee01b023d453
7989226905 7cbfbd /OUTPUT tif —-optfile C:
¥Users¥KAZUYO I¥AppData¥Local¥Temp/ v

acacanaa s -

[ 0% Cancel

Run as Batch Process** | | Run | Close Help

Browser Layers

L Type to locate (Ctrl+K) 1 legend entries removed. Coordinate | 30030-0585 | Scale 1:430413 |~ | (g Maenifier | 100K % | Rotstion |0D° 3| V| Render @ EPSG4326 @@ g‘
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® New layer is created and added to the layer window.

Q
® P A F® M) (G4 @ 0 ~~ Rila Bl @ @ 1 ¢
Ve 220350 D) R WL ER Y QG > » d» @» A
Ta) &
”
X A
3 Layers @®
Vo |l¢eawnyi-aan
Ec v ¥ ASTER 20010805 Band123 Uganda-1
~ V| ¥ datall3avnir3n
B2 B
9 227
Q ~ V| M datall3avnir2
A o
Q 255
\(ﬁ v~ |V ¥ datal.l3a.vnirl
= Mo
QO = 255
@ v Q Merge X
@ Parameters Log
'\‘-)"" -~ processing_8dS84cbf9dalad02abccel0lf2360£8377/ =
= €7cl2174a5dc4e709421746£e57931c4/mergeInputFiles. txt
V" . GDAL command output:
'I:' - done.
i Execution completed in 057 seconds
Results:
i {'OUTPUT': 'C:/Users/Kazuyo '
M 'Hirose/Documents/Country/Uganda/
EE:I 108050839101305159007/
L ASTER_20010805_Bandl23_Uganda-l.tif'}
:@ Loadine resulting layers
¢ Algorithm "Merge' finished -
B & Y%
0% Cancel
Run as Batch Process®* Run Close Help
Browser Layers
. Type to locate (Ctri+K) 1 legend entries removed. Coordinate | 30015.-0745 | Scale [1:430413  ~ | (g Maenifier | 100K % | Rotstion |00° 2| VI Render @ ePscaszs @ 5
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Change property

® Select merged layer, click right mouse button and select “Properties”.
® Select “Symbology” tub and confirm that there are three bands.

Q

MG 2000 D

Layers

« 3 %Y i B W}

u

V| ¥ ASTER 20010805 Band123 Uganda-1

‘ ) B R B &l @ @
»d s GO el fe 9 @& ~ >

B~

B

=)
E3]

v V| @ datall3awvnir3n
Mo
227

q Information
‘&\ Source

(Z( Symbology

- I._! Transparency
- B8 Histogram
Q/ Rendering
B Pyramids

l Metadata

fﬁ:ﬁé@@@o‘&gg\o\’%:ﬂoﬁ

:{ H

-
— Legend

QGIS Server

Browser Layers

L Type to locate (Ctrl+K)

(2 Layer Properties - ASTER_20010805_Band123_Uganda-1| Symbology

w Band Rendering
Render type | Multiband color v
Red band Band 1 {Red)
Min |0

Green band | Band 2 (Green)

Min |0 Max 255

Blue band Band 3 (Blue) v
Min [0 Max 1255

Gontrast

R S ant No enhancement v

P Min / Max Value Settines

w Color Rendering

Blending mode | Normal v  Reset
Brightness L 0 S| | Contrast e | 0 >
R by broist —_— n all fvavianata [0 = b

Style - | ) OK | Cancel Apply Help

1 legend entries removed. Coordinate | 29 340,-03391 % Scale 1:430413  « u Magnifier | 100% % Rotstion 00° SV Render @EPSG:‘BQG

» & »

" o
@spacesysfems

R &
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Change property

@spacesysfems

® Select merged layer, click right mouse button and select “Properties”.
® Select “Symbology” tub and confirm that there are three bands.

(2 Layer Properties - ASTER_20010805_Band123 Uganda-1 | Symbology

ri Information

J\g\ Source

# Symbology
l._g Transpare
u Histogram

1dering

- Pyramids

‘ Metadata

Legend

QGIS Server

Layers

(CAr kD

w Band Rendering

Render type | fultioed

Not set
Red band Band 1 (Red)
Band 2 (Green)
Green band
Min |0 Ma | 255
Blue band Band % (Blue)
Min |0 -
Gt No erhancement —
enhancement

P Min / Max Value Settines

w Color Rendering

Blending mode | Mormal
Erightress e
[ —

Style r |

1 legend entries removed.

Q Layer Properties - ASTER_20010805_Band123_Uganda-1 | Symbology

w Band Rendering

Render type | Multiband color

Max 255 G Layer Properties - ASTER 20010805 Band123_Uganda-1| Symbelogy

Red band Band 1 {Red) -
Not set
Band 1 (Red)

Green band
Band 3 (Blue)

Blue band Band 3 (Blue) -

Min 0
gﬁg‘;:ﬁc‘:mem No enhancement -

P Min / Max Value Settings

w Golor Rendering

Blending mode | Mormal
Erighthess e

Bthambinn

Style -

(I Information

-

= I Contrast
all
oK

R P

Gancel

w Band Rendering

Render type | Multiband color -
Fed band Band 3 (Blue} B
Min |0 May | 265
Green band Not set
Band 2 (Green)
Elue band Band 3 (Blug)
Iiry |0 Mane | 266
Gaontrast
erhancement | M0 Enhancement =
P Min / Max Value Settines
w Golor Rendering
EBlending mode | Mormal = %> Reset
Erighthess — i = I Contragt e 1] =
b b —_— n P R P - b/
Style - | [u]8 | Cance| Apply Help

12
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Change property @spacesysfems

® In “Band rendering” group, change band color and push “OK”,
® Confirm that the color of merged layer is changed.

Q@

Q

e L ARI PPRLB D

Layers @®
« @ » 7 [F 2 g

v ¥ ASTER 20010805 Band123 Uganda-1
v v ¥ datall3awvnir3n
B

227

v v
i (2 Layer Properties - ASTER_20010805_Band123_Uganda-1 | Symbology

w Band Rendering

5 Qﬁ@@c‘&o\o"%t’oﬁ

o :
(i * Information Render type | Multiband color -
:{s\ Source Red band Band 3 (Blue)
(Z,( Symbology s
Green band | Band 2 (Green)
v I.. Transparency
e Min
= I histogram Blue band | Band 1 (Red)
‘/ Rendering Min 10
Contrast
Pyrainih oA st ent No enhancement

P Min / Max Value Settines

l‘ Metadata

-
— Legend

w Color Rendering

K B

Blending mode | Normal -

QGIS Server e

Brightness — 0 % | Contrast e |

Saturation e 0 < || Grayscale | Off

Style - | oK || Cancel

Browser Layers

L Type to locate (Ctrl+K) 1 legend entries removed. Coordinate | 29 947,-0847 % Scale |1:430413 - Magnifier | 100% % | Rotstion 00° 2| V| Render @ EPSG4326 Q g‘
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Remove single-band layer

® Select single band layers, click right mouse button and select “Remove”,
® Remove these layers.

Q - 8 X
Setings Plugins Vectgr Baster Dotabase Web Mesh SCP Progessing Help
1 g, o wn ’ S
Ve ppHl PP A L b uh % - » b @» A
RiX & Q
\[ Layers
3 o %3 c 7
o bt L Ve LRI PB A ([} ~ -
", ./ 3 ASTIR 2001005 Badiz3 Vg 1
B > datat3avoiin
Layers e®
% \ Vo |« i 2 ¢ - e
/ 'n v ¥ ASTER 20010805_Band123_Uganda-1
R —— ~ V I datelBavniin
@ . 5 | I
& ’ 227
":« - (+} ~ v ¥ datalBavnir2
= z o
) 5 Z £ 255
- st ~ v I datali3a.vnin
d o
Ve 'n < 255
=) @ -
M L)
P | Remove3legend enries?
P OK || Gancel
=] L7 ]
@ Vo~
e ]
<o
oA
=
&
Bomer  Lay w
- 8 X
er Setings Dlugins \Vector Baster Dotsbase Web Mesh SCP Progessing Help
n LI
Pl | AR b WG~ > a» @ A
BRiX A
3 + 20
v ¥ ASTER 20010805 Band123 Uganda-1 Coordinate | 293490584 |9 Scele 1:430413 |~ | (@ Mesnifier | 100K 2| Rotation [00° 3| [V Render @ersadcrs @ LI
.
a
L
Browssr | Layers
3 Wand anties removes Cocrdnate| 295410700 |9 Scak 143003 = | @ Meeniber 1008 2| Rowten [00° 3|V Pt @epsoane @ 9
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Change contrast enhancement ) spacesystems

® Zoom in to the region of interest on merged layer.
® Check Menu button View-Toolbars-Raster Toolbar.
® C(lick button |, to enhance contrast of the image.

@ *Untitled Project - QGIS = X
Project Edit Layer Settings Plugins Vector Raster Database Web Mesh SCP Processing Help
@ “:’ { gy New Map View Ctrl+M
¢ New 3D Map View Ctrl+Alt+M
| Pan Map
=, A
e &% Pan Map to Selection
4 W ZoomIn Ctrl+Alt++
&

= Zoom Out Ctrl+Alt+-
@, Identify Features Ctrl+Shift+

Measure »

% Statistical Summary
T3 Zoom Eull Ctrl+Shift+F

Selection Ctrl+)

§2 Zoom to Layer Advanced Digitizing Toolbar

[ Zoom to Native Resolution (100%) V| Attributes Toolbar

<

Data Source Manager Toolbar

Database Toolbar

g Zoom Last

Ll

Decorations | Digitizing Toolbar

Help Toolbar
Label Toolbar

Preview Mode »

& Show Map Tips

¥, New Spatial Bookmark... Ctrl+B
¥ Show Spatial Bookmarks Ctrl+Shift+B

‘gig}éb:@c'@{)\s\.gg(’oﬁ

V| Manage Layers Toolbar

<

V| Map Navigation Toolbar

58

[

¥ Show Spatial Bookmark Manager V| Plugins Toolbar

Project Toolbar

il % Refresh Fs
e . Raster Toolbar
®. Show All Layers Ctrl+Shift+U
&:] i X Shape Digitizing Toolbar
Hide All Layers Ctrl+Shift+H
Snapping Toolbar
y ®; Show Selected Layers

. V| Vector Toolbar
Hide Selected Layers

_ Web Toolbar
Hide Deselected Layers
V| GRASS
Panels »
GarminCustomMap
V| ImportPhotos
Toggle Full Screen Mode F11 .
Toggle Panel Visibili Ctrl+Tab %) ko
oggle Panel Visibili trl+Tal
Sro % i Y SCP Working Toolbar
X Typmito’ ook 30,2 Map Only CulShilts Taks SCP Edit Toolbar 158226 | v | (g Meenifier 100K 2| Rotstion |00° 3| VIRender @ersaaazs @ £
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Change contrast enhancement

® Confirm that contrast enhancement is changed.

(@ *Untitled Project - QGIS - b
Project Edit View Layer Settings Plugins Vector Raster Database Web Mesh SCP Processing Help

\@\@'@é@ﬂ PPLR-GBELEDOR E\ﬁﬁn\ﬁ? I A I s - > d» &» A5

ALayers @ 3
« @l ® TV - -HRL

ASTER 20010805 Band123 Uganda-1 |

<

4

<

FSEDHDHSBENCRNS

e

Browser | Layers
~ | @@ Maenifier | 100%

B

| Rotation |00° (3| v Render @ EPsG432s @ g@

49

| Q Type to locate (Ctrl+K) ‘ Goordinate | 301843.-05337 ‘% Scale |1:158226
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@spacesysfems

Merge single-band layer in multi-band laye

Create one more image to merge horizontally.

From “Raster” menu, select “Miscellaneous” and “Merge”.
Open “Merge” window.

Select files with the vnir to the end in another folder.

R S SR 2 !

G I

HHDH8MINS

\? Terrain Analysis
Zonal statistics
Projections
Conversion

Extraction

Analysis

Build a quick mosaic from a set of images

B3 s SUR T T
Catalog)...

Merge...
' Information..
W, Build Overviews (Pyramids)...

Project Edit Wiew Layer Settines Plugins Vector Database Web Progessine SCP  Help
= B D E Raster Calculator... Oy A & —- N 2 =5 T
D L Lo \H @ 2:‘ Alien Rasters... p p @ 4 Ko qk Q @ 2 o Y o < i :mv
- Georeferencer N @ &n @ @ =
o0 v @B o= = Nd & & @ 6 ( o G @ O @
jf/. f n * B /K UI] 9 Heatmap - - E 7\9 a 3 & VY
Layers Panel Interpolation 5

[ i Vs st oo [

— HDPC-UT(M:) ¥

N datal B2t L4

« 4 ||« HDPC-UT(M:) » USB » Data » ASTBO10805083918 v|®| | AsTBO10205083918DEE £
22 HLLTS- B~ ™M @
9 =l * [ datalizademsh - datal.|3atir 2.
a & Fouo-f HedatalBademzstif e datall3atic] L
7 datal.3a.gh datal.3a.tirl4.tif
W F3IkyT JgsteBag HpdataBa 14
. HedatalBaswirdtif [ | dataliZatirsh
Ve~ sk M datalBaswirs tf A datal.Bavnirl tf
= E7Fr Mo datal BaswiGtif  HedatalBavnir i
@a - Ny R datalBaswirTtf | Hedatal.Bavnisn.tf
D z3-yws HedatalBaswirtif || datallZavnirsh
5 ‘i Windows (G e datal |32 swirdtf
2 Data (D) || datal.I3a.swirch
- ;
¥ datal Batirl0f
= Datal (G1)

TrA b () |"data1‘Ba.vnir3n.tii" "datall3avnirltif' "datal3avnirl tf" V| ‘AH files () (%)

h |

E{(Q)
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Merge single-band layer in multi-band layer iR/

® From “Raster” menu, select “Miscellaneous” and “Merge”.
® Open “Merge” window.
® Select files with the vnirl, vnir2 and vnir3n.

( *Untitled Project - QGIS = X
Project Edit View BEWEY Settings Plugins Vector Raster Database Web Mesh SCP Processing Help
A d \5 Data Source Manager Ctrl+L y f Y 0\, >\ N 1
@ L. S S| } \ f: P R i AR v Qd @ » > B> » P> »
| Create Layer »

V Add Vector Layer... Ctrl+Shift+V
+ Add Raster Layer... Ctrl+Shift+R
B Add Mesh Layer...

Embed Layers and Groups...
Add from Layer Definition File...

i Copy Style 95 Add Delimited Text Layer... Ctrl+Shift+T
P. 'u Add PostGIS Layers... Ctrl+Shift+D
i Copy Layer /% Add Spatialite Layer... Ctrl+Shift+L
D B Add MSSQL Spatial Layer...
Open Attribute Table F& Q Ad 23 ~
gle Editing | Ad #* 7497 7OER h
N 2 Ad | | datat.I3a.demsh
@ Ad @ OneDrive 8] datat.13a.demzs.tif
|| datat.I3a.gh
Save As... % af Epc . j data1.l3a.3wir4.tif
Save As Layer Definition File... @ Ad 3D 77“/.1':7} 5 datal.|3a.swirS.tif
"1 Remove Layer/Group Ctrl+D @Ad b 5’-‘7‘/D—I~ [5] datat.i3a.swirs.tif
] Duplicate Layer(s) ¥ Ad - 7':17 i ﬂ o
Set Scale Visibility of Layer(s) ? I:‘T'll)l’* i] ja:a:.:z.sw?:.:f:
Set CRS of Layer(s) Ctrl+Shift+C i t::v ij d:t:1:lsa:z:rs;1l

Set Project CRS from Layer [8] datat.i3atirt0.tif

D -3y =
Layer Properties... ) |&] datal.3atir11.tif
s Windows (C) . )
_'|; Filter. Ctrl+F |&] datat.l3atiri2.tif
% Labiiis o HO-PEEAD) [&] datat.izatiri3.tif
E\E] ©9 Show in Overview = HD-PGF-A (D)) |8] datal.l3a.tir14.tif
y e || datat.I3a.tirsh
©o Show All in Overview o ®vhI-7 || datat.13a.vnirt.tif

| ©8 Hide All from Overview 8] datat.l3avnir2.tif

\ﬂ datal.I3a.vnir3n.tif
\_] datatl.l3a.vnirsh

Browser Layers

< >
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Merge single-band layer in multi-band layer iR/

® Confirm that new merged layer is created and added in layer window.
® Merge three layers and change data type as “Byte” and save

( *Untitled Project - QGIS - X

Project Edit View Layer Settings Plugins Vector IEE Database Web Mesh SCP Processing Help
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Cutput data type Cutput data tvpe £dd Directory-
) C o
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n
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n
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=] Letyer WSEer Layers
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Merge single-band layer in multi-band layer iR/

® Created image is opened and click button “Zoom Full” 3
® Confirm that new merged layer is created and added in layer window.

(2 *Untitled Project - QGIS — X
Project Edit View Layer Settings Plugins Vector Raster Database Web Mesh SCP Processing Help
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Change property @spacesysfems

® Open property window and change color.

(2 *Untitled Project - QGIS —; X
Project Edit View Layer Settings Plugins Vector Raster Database Web Mesh SCP Processing Help
& =) ] (3 =] - \ ') Y y o ) 1 &
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Merge multi-band layer @spacesysfems

® From “Raster” menu, select “Miscellaneous” and “Merge”.
® Open “Merge” window.
® Select “Input files” and “Output file” .

( *Untitled Project - QGIS — X
Project Edit View Layer Settings Plugins Vector JiESGEd Database Web Mesh SCP Processing Help
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V| " ASTER 20010805_Band123_Uganda-1 Extraction »| B} Raster Information... arameters og ik, f; P [l {; e Y
% Conversion » : erge Input layers =l e
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P & Save to a Temporary File
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Save to File...
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nge File Encoding (System)...
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Merge multi-band layer

@spacesysfems
® Don’t check the box of “Place each input file into a separate band”
because of merging horizontal images in this case.

s 9497 FIEA
- ) : @ OneDrive
Q 3 Q Merge X b
: - - I pC
@ ‘g.:.; Parameters Log h i} LD, W O Y n o ((é l@ »
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Output data type 5| FFaAvb
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2o Windows (C)
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Assien specified “nodata” value to output [optional]

Not set =
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A
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python -m edal meree -n 0 -ot Float32 -of GTiff -0 "C:/Users/ - 8 A TAIS-DIEST

| 0% Cancel
Run as Batch Process™ | | Run | Close Help
Browser Layers
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Merge multi-band layer @spacesysfems

® Two multi band layer is merged.

( *Untitled Project - QGIS - X
Project Edit View Layer Settings Plugins Vector Raster Database Web Mesh SCP Processing Help
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Change property @spacesysfems

® Select merged layer, click right mouse button and select “Properties”.
® Change color and contrast enhancement in “Symbology” tub.

Q t g —

NSEARIPRPRALBEINS hielhie v 6@ 7 . de B AL
- B %

Layers @®
« @@V -BADL

<<
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Change property

@spacesysfems

® Select “Transparency” tub and check “No data value” option as “0”

Q =)
o (=) IORIC e =] [0 =~ | ! \ & . @ . .4 ¢
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Change property @spaaesysfems

® Merged image is created.

(2 *Untitled Project - QGIS
Project Edit View Layer Settings Plugins Vector Raster Database Web Mesh SCP Processing Help
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Change property

® From “Raster” menu, select “Extraction” and “Clip Raster by Extent”.

(2 *Untitled Project - QGIS
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» ﬂ Clip Raster by Extent...
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Layers Analysis »
AV i = o Projections »
o |« . T AiF = 4
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Clip region of interest

® Enter coordinate in Clip Raster by Extent window as below.
® Push “OK”"

}," gjj‘ «}E\j ‘7;; @‘; L g 1 ?‘D L1 n G \% l@ » » é » &N » P) »
T
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Clip region of interest @spacesysfems

® Enter coordinate in Clip Raster by Extent window as below.
® Enter the file name and push “OK”

Q
P = T 0 @ O 1 T 7 [ RiLs | Blia T AR’ A 5
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Clip region of interest spacesystems

® Zoom in and confirm clipped region.
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Change property @spacesmems

® Open property window and change color.
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Change property

® Open property window and change color.

( *Untitled Project - QGIS
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Create SWIR and TIR

® Make clipped images of SWIR and TIR.
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Save project

® From “Project” menu, select “Save As”.
® Save this project.
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Artisanal, Small-scale
[ lllegal mining monitoring
In Kenya
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Artisanal, Small-scale Mining in Kenya @spacesysfems
IN PICTURES: Kenya's gold rush

AFRICA Friday 11 March 2016 - 12:25pm

Thousands of artisanal and small-scale miners find themselves working in perilous conditions

in western Kenya, where large-scale gold deposits have reportedly been located. Photo: DAI
KUROKAWA

According to the Mines and Geology Department at the Ministry of Environment and
Natural Resources of Kenya, the gold capacity of Migori alone stands at 34 tonnes
per year. That could earn the country some $670 million (67 billion Kenya shillings)
annually, according to a local report.
(http://lwww.epa.eu/feature-packages/archive/2016/gold-mining-in-Kenya)
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Artisanal, Small-scale Mining in Kenya

Geology of Migori Goldbelt (Sanders, 1964) by Internet

: i
= Nyahza Belt
-L-E‘"' | B2 avwonaian or

TANZANIA

g km an

Ichang'l (1990)

Migori Geology on Sentinel-2

L B e e ]
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Artisanal, Small-scale Mining in Kenya

€ Hypothesis
Bare land for long time and rapid land expansion may suggest mining
activities.
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Artisanal, Small-scale Mining in Kenya @spacesysfems

Macalder Tailings Resource

The Macalder VMS deposit was discovered in the
mid-1930s and mined for copper and gold till mid-
1970s. The tailings produced during that period
have been demonstrated by Red Rock to contain
potentially economic levels of residual gold
mineralization amenable to cyanide leach extraction.
A JORC Measured Mineral Resource Estimate has
since been completed.

Measured ore: 1.3 Mt (1.65g/tAu) S Pas .
Geology | ‘
Gold enrichment within the MGB is
predominantly found in and around < ; ¢
shear zones associated with quartz- g
carbonate veining and significant ‘ _ x" ;
alteration, as well as banded iron e e
formations (BIFs) and poly-metallic I s — Q{ENYA
Volcanogenic Massive Sulphides (VMS). - "‘:'M N ora ACA | i
- - - Kilimapesa GO P
https://www.rrrplc.com/projects-and- - > J SR

investments/gold/migori-gold-project/
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Sentinel-2 (10m resolution) and Google Earth Images

" o
@spacesysfems

Goaogle Earth Engine es Ed .
Sentinel-2
o | = S Launch dates:
iy Tk 2A: 2015/06/23
et X, - 2B: 2017/03/07
=5 — |2cC: 2019
.| 2015/12/29
. ~2017/05/22
3;/1%55

B |Importance for estimating illegal mining activity
1. Frequent observation:

to identify the long-term bare land to discriminate agricultural land
1. Object shapes ( area, road-network, settlement and etc.):

» Irregular shape => informal activity

= Angular shape, systematic pattern => legal activity
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ASTER/Sentinel-2 and Google Earth Images
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Google Earth Images
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Sentinel-2 (10m resolution) @spacesysfems
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Mining Cadastre
Home
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Help and FAQ
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Licence Applications
Conversion to WGS84
Managing my Licence
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Explosives

External Links

Madini Facebook
Madini Twitter

Share on Social Media

Map Portal
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Step 1. Monitoring of Free images
(L-8, ASTER and Sentinel-2)

Step 2. Assessing images by
NDVI with Google Earth on QGIS

Step 3. Comparing cadastre data

L 2

Step 4. Detecting illegal mining
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lllegal mining monitoring by others for same place

The extent of land disturbance to land is significant in a relatively short time
(Figure A38, next page). The changing footprint illustrates both rapid changes in the magnitude of
environmental impacts and economic significance common in many ASM areas.

Figure A38: Evolution of Osiri between 2011 and 2014: The environmental footprint has
increased as the area’s economic significance has grown.
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This document is an output from a project funded by the UK De for ional D (DFID) through the
Research for Evidence Division (RED) for the benefit of developing countries. However, the views expressed and information
contained in it is not necessarily those of, or endorsed by DFID, which can accept no ibility for such views o i ion or
for any reliance placed on them.
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3) Project experience with Myanmar (2016) @spacesysfems
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3) Project experience with Myanmar (2016) @spaaesysfems

aste rock and sediment
~ from Mong Len Gold Mining Area
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3) Project experience with Myanmar (2016) @spaoesystems

The dominant method used by large scale gold mines is chemical

leaching using cyanide, while small-scale miners use mercury.

B While cyanide and mercury are both hazardous substances.

B Cyanide can obtain very high recovery rates - often 90% of the gold in
the ore - and it is cheap.

B Innovations in cyanide leaching allowed large deposits of low gold grade
to be processed, allowing formerly uneconomical ore deposits to be
exploited.

B For the same set of reasons, the use of cyanide has become
iIncreasingly adopted by small-scale miners.

B Unfortunately, misuse and poor management of cyanide in small-scale

mining is common and has led to disastrous local pollution and safety

hazards.

UNEP(2012), A practical guide ‘reducing mercury use in artisanal and
small-scale gold mining’
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3) Mong Len Mining Area (Landsat-8, 2013/04/01) @spacesygems




3) Mong Len Mining Area (Sentinle-2, 2017/11/17)




3) Mong Len Mining Area (Sentinle-2, 2019/05/05




